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If you haven’t already, sign in to your Apple Account to get started.

Subscribe to Apple TV+. Apple TV+ is a subscription streaming service featuring Apple
Originals—award-winning films, series, compelling dramas, groundbreaking
documentaries, kids’ entertainment, comedies, and more—with new items added every
month. To subscribe, click the Apple TV+ tab in the Apple TV app, then click Subscribe.
You may be eligible for a free trial, in which case, click Access Free Trial.

Note: Availability of Apple TV+ may vary by country or region. Learn 
.

Search for shows or movies. In the search field at the top-left corner of the TV app,
type the name of a show, movie, or actor, then press Return. Search results are grouped
into Top Results, Movies, and TV Shows. Not sure what you’re looking for? Browse the
Home, Apple TV+, or Store tabs to discover new shows and movies.

Buy or rent. When you find a movie or TV show you want to watch, you can choose to
buy or rent it in the Store. To watch purchased or rented content, go to your Library.
Channels you’ve subscribed to are available on all devices, and can be used by up to six
family members through Family Sharing.

Pick up where you left off. If you watch Apple TV on other devices, continue watching
right where you left off. Click Home, then choose the content you want to continue from
the Up Next row.

Learn more. See the .

what’s available in
your country or region

Apple TV User Guide

https://support.apple.com/118205
help:openbook='com.apple.TV.help'
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Podcasts

Use Apple Podcasts to browse, follow, and listen to favorite podcasts on your Mac.
Personal recommendations help you discover new podcasts grouped by topics you care
about.

If you haven’t already, sign in to your Apple Account to get started.

Search for podcasts. Type a podcast’s name in the search field, followed by the Return
key to quickly find your favorites. You can also search by host name, guest, or topic to
get a list of shows where they’re mentioned or discussed.

Play a podcast. Start playing a podcast by moving the pointer over the show or episode
you want to play, then click .

Siri: Say something like: “Continue playing the last podcast.”
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Follow your favorites. Click Follow to add a show to your favorites so that you never
miss a new episode. See what’s new in the Recently Updated tab of your Library.

Save episodes to your library. To save a single episode to your library, click . To
download a podcast for offline listening, click . When you download podcasts to your
device, you can access them on that device when you’re offline.

Learn more. See the .

Search the web with Safari
Enjoy the internet with blazing fast speed, optimized battery life, and powerful privacy
protections built right in. Safari works seamlessly and syncs your passcodes, bookmarks,
history, tabs, and more across all your Apple devices using the same Apple Account, so
you get the same Safari wherever you browse.

Podcasts User Guide

help:openbook='com.apple.podcasts.help'
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Change your homepage. Make your browser your own by choosing a homepage.
Choose Safari > Settings, then click General. In the Homepage field, enter a webpage
address. To simply use the webpage you’re currently viewing, click Set to Current Page.

Start searching. Start typing a word or website address—Safari shows you matching
websites, as well as suggested websites. Or select a favorite or frequently visited item
from your Safari start page.

Simplify reading on the web. Use the smarter, redesigned Reader to view a webpage—
such as a recipe, news article, or blog post—formatted for easy reading, presented
without ads, navigation, or other distracting items. Click  in the Smart Search field, then
click Show Reader. When you’re in Reader mode, click  to change the font and color.
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Add and view bookmarks. Save frequently visited websites—favorite stores, online news
sites, blogs, and more—in your bookmarks for quick access. To bookmark the page
you’re viewing, click  in the toolbar, then choose Add Bookmark. To view your
bookmarks, click , then select .

Organize with Tabs. Avoid cluttering your desktop with multiple windows. You can
instead view multiple webpages in a single Safari window by using tabs. To open a new
tab, click  in the Safari toolbar, or press Command-T.

Make a purchase with Apple Pay. When you shop online using Safari, you can make
easy, secure, and private purchases on websites using Apple Pay on your Mac. When you
choose Apple Pay on a website, place your finger lightly on the Touch ID sensor on your
Magic Keyboard with Touch ID. You can also confirm payment using your iPhone or Apple
Watch.

With Apple Pay, your Apple Card and other credit or debit card information is never
stored or shared by Apple with the merchant. For learn more, see the Apple Support
articles , , and 

.

Note: Apple Pay and Apple Card aren’t available in all countries or regions. For
information about Apple Pay, go to . For information about current card issuers,
see the Apple Support article . For information about
Apple Card, see .

Set up Apple Pay Make purchases using Apple Pay Change or remove the
payment cards that you use with Apple Pay

Apple Pay
Apple Pay participating banks

Apple Card Support

https://support.apple.com/HT204506
https://support.apple.com/102626
https://support.apple.com/118219
https://www.apple.com/apple-pay
https://support.apple.com/HT204916
https://support.apple.com/apple-card
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Use Private Browsing. Create a private browsing window by choosing File > New Private
Window. When you use private browsing, Safari won’t remember your history, helps
prevent websites from tracking you, completely blocks known trackers from loading on
pages, and removes tracking used to identify you from URLs as you browse.

To better understand how a site treats your privacy, click   to the left of the active tab to
view the cross-site trackers that Safari is blocking on each website. Click  to see a
privacy report with more details about the website’s active trackers.

Learn more. See the .

In the U.S., Apple Pay is a service provided by Apple Payments Services LLC, a subsidiary of Apple Inc. In
other countries and regions, Apple Pay is a service provided by certain Apple affiliates, as designated by the

. Neither Apple Inc. nor Apple Payments Services LLC nor any Apple affiliate is a
bank. Any card used in Apple Pay is offered by the card issuer.

Design with iWork on Mac
With iWork—Pages, Numbers, and Keynote—you can create amazing documents,
spreadsheets, and presentations on your iMac. Templates and design tools make it easy
to get started. And with real-time collaboration, your team can work together, whether
they’re on Mac, iPad, iPhone, or a PC.

Pages

Use Pages to create any kind
of document you want, from a
simple word-processing
document that’s mainly text, to
a page layout document with
graphics, interesting font
treatments, and more.

Numbers

Create spreadsheets with more
than 250 powerful functions
and features to help you
visualize and analyze data.
Templates give you a head
start when you create budgets,
invoices, team rosters, and
more.

Keynote

Use Keynote to design create
beautiful and engaging
presentations. Choose one of
the more than 30 predesigned
themes and make it your own
by adding text, 3D objects, and
changing the color scheme.

Create documents in Pages, Numbers and Keynote. To get started, open Pages,
Numbers, or Keynote, select New Document, then choose a template or theme or click
Blank. Click Create to open the document and start making changes.

Safari User Guide

Apple Pay privacy notice

help:openbook='com.apple.Safari.help'
https://www.apple.com/legal/privacy/data/en/apple-pay
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All your formatting tools, in one place. Click  in the Pages, Numbers, or Keynote
toolbars to open the Format inspector. Select something in your document, and the
formatting options for it appear.
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Collaborate on documents with iCloud. Work together in real time with iWork. With
Activity Stream, a detailed list in the sidebar allows you to see edits and comments made
by collaborators. In a Pages, Numbers, or Keynote file, click , choose Collaborate, then
choose how you want to share the file. You can also choose to Send a Copy.

Tip: Turn on change tracking to see the changes you and others make to a document.
Each person’s edits and comments are color-coded, so you can see who made each
change. Choose Edit > Track Changes to show the change tracking toolbar.
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Learn more. See the , , and .

Get more apps
The App Store is your one-stop-shop to find, purchase, and download new apps and
games for your iMac. You can also get the latest updates, view and manage
subscriptions, and more. And all you need is an Apple Account.

Pages User Guide Numbers User Guide Keynote User Guide

help:openbook='com.apple.iWork.Pages.remote.help'
help:openbook='com.apple.iWork.Numbers.remote.help'
help:openbook='com.apple.iWork.Keynote.remote.help'
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Sign in to your Apple Account. To download free apps, sign in to your Apple Account.
Go to the App Store app  on your Mac, then click Sign In at the bottom of the sidebar.

Note: To purchase apps, you must also set up an account with purchasing information.

If you don’t have an Apple Account, click Sign In, then Create Apple Account. If you have
an Apple Account, but don’t remember your password, click “Forgot Apple Account?” to
recover it.

Get more apps. Apps you download from the App Store appear automatically in
Launchpad. In the App Store app  on your Mac, do any of the following:

Know exactly what you’re looking for? In the search field at the top-left of the window,
type the app name—such as Microsoft Office, Excel, and Powerpoint—then press
Return.

Want to explore available apps? Choose a tab in the sidebar—such as Create, Work,
or Play—and browse through the results.

Siri: Say something like: “Find apps for kids.”
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Already purchased the app? Click your name on the bottom-left to view your account
information, including a list of previously purchased apps. Apps and subscriptions
can be managed in the Purchase History section of Account settings.

Update apps and games. If you see a red badge on the App Store icon in the Dock,
there are updates available. In the App Store app , click the Updates tab in the sidebar
to see available updates, then click the Update button.

Subscribe to Apple Arcade. Click Arcade to subscribe to Apple Arcade. When you
subscribe to Apple Arcade, you gain access to 200+ fun games, with more added all the
time. To learn more about the Apple Arcade subscription service, see the Apple Support
article .

Get games. In the App Store, click the Play tab in the sidebar to search and discover
games you can download and play. You can search for a game by typing the name in the
search field, then pressing the Return key. To buy or download the game, click Get or the
price next to the game.

Learn more. See the .

Play games with Apple Arcade

App Store User Guide

https://support.apple.com/102106
help:openbook='com.apple.AppStore.help'
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Use the Mac User Guide
The Mac User Guide has a lot more information about how to use your iMac.

Get help. Go the the Tips App or click  in the Dock, then click the Help menu in the
menu bar and choose Mac User Guide. Type a question or term in the search field, then
choose a topic from the results list.

Explore topics. To find a topic in the Mac User Guide, you can browse or search. To
browse, click “Table of Contents” to see the list of topics, then click a topic to read it. Or
type what you want to find in the search field to go right to your answer.

Tip: If you can’t remember the location of a menu item in an app, search for it in Help.
Place the pointer over the result, and an arrow shows you the command.

Find answers
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Learn more. See the .

Are you new to Mac?
If this is your first Mac computer, here is some helpful information to get you up to speed
—especially if you came from a Windows environment.

Familiarize yourself with the desktop. The desktop is where you do your work, and
where you can quickly open apps, search, and organize files.

Mac User Guide

help:openbook='com.apple.machelp'
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On the desktop you’ll find:

The menu bar: The menu bar for the desktop or the active open app is always at the
top of the screen. Use menus to find options and perform tasks in apps. For
information about items in the menu bar, such as the Apple menu and the Help menu,
see .

The Dock: The Dock is similar to the taskbar and Start menu in Windows and appears
at the bottom of the desktop (but you can change its location in System Settings).
The Dock makes it easy to see all the apps you have open and quickly launch your
favorite apps. To open an app, click its icon in the Dock. You can also open apps using
Launchpad. See .

The Finder: Click  in the Dock to open the Finder, where you organize and locate
your files (similar to File Explorer in Windows). Use the buttons at the top of the
Finder window to change how you view your files—as icons , in a list , in columns

, or in a gallery . In any view, you can select a file and press the Space bar to see
a Quick Look preview without opening the file. See .

The Spotlight menu: Spotlight lets you search for anything on your Mac, including
documents, contacts, email messages, and more. You can also launch apps and
search on the web. To open Spotlight, click  at the top right of the screen or press

Desktop and menu bar on your Mac

The Dock on your Mac

Finder on your Mac
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Command-Space bar. See .

System Settings: System Settings  is similar to the Control Panel in Windows.
Customize your Mac with settings for the desktop, Dock, display, Bluetooth, network,
and much more. See .

Get to know the keyboard and trackpad. The Command key  on Mac is generally the
same as the Control key on Windows. For example, use Command-C and Command-V to
copy and paste content. The Return key on Mac is the same as the Enter key on
Windows, while the Delete key is the same as Backspace. If you want to forward delete,
Press Fn-Delete.

For a list of Mac keyboard shortcuts and differences between Mac and Windows
keyboards, see the Apple Support article . Also see

. For more shortcuts in this guide, see 
.

Install apps. You can download apps from the App Store or the internet. When you
download an app from the internet, you get a disk image file (ending in .dmg) or package
file (.pkg). To install the app, locate the .dmg or .pkg file in your Downloads folder,
double-click it, then follow the onscreen instructions. You’re prompted to delete the disk
image or package file after you install the app.

To uninstall an app, find the app in the Applications folder in Finder, then drag the app to
the Trash. Some apps have an Uninstaller, which you can use to delete the app and other
files associated with it. See .

Maximize, minimize, and close windows. You can have multiple windows for an app
open at a time. Use the buttons in the top-left corner of a window to resize and close
windows.

Click  or press Command-W to close the window, but not the app. Press Option-
Command-W to close all open windows for the app. Press Command-Q to quit the
app.

Click  to minimize a window (or press Command-M). Minimizing a window leaves
the app open but reduces the window to an icon on the right side of the Dock. Click
the icon to restore the window to its previous size.

Click  to open your app full-screen. To maximize the window, hold the Option key
and click the button. Or hold the pointer over the button to see more options, such as
tiling the window. Press Esc to return the window to its previous size.

Move windows. Drag the window by its title bar to put it where you want it. Some
windows can’t be moved. See .

Spotlight on your Mac

System Settings on your Mac

Mac tips for Windows switchers
Windows keys on a Mac keyboard Keyboard
shortcuts on your Mac

Install and uninstall apps

Manage windows on Mac

https://support.apple.com/102323
help:anchor='cpmh0152'%20bookID='com.apple.machelp'
help:anchor='mh35835'%20bookID='com.apple.machelp'
help:anchor='mchlp2469'%20bookID='com.apple.machelp'
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Switch between app windows. Press Command-Tab to quickly switch to the previous
app. When you have several app windows open, press and hold Command, then press
Tab to see icons for all the open apps. While holding Command, press Tab (or the arrow
keys) to move between the apps and select the one you want to be active. Release the
Command key to work in the active app.

Take a screenshot. Press Command-Shift-5 to access the Screenshot Utility. See 
.

Let Siri do tasks for you. To activate Siri on your iMac, click  or  in the menu bar. If
the option is turned on, you can say “Hey Siri” or “Siri” and continue with your request.
You can also press and hold the Dictation/Siri key (F5) on the Magic Keyboard, or use the
keyboard shortcut selected in Siri settings. Ask Siri to open a folder, launch an app, make
the screen brighter, and other tasks. See .

Use your Mac with iPhone, iPad, and Apple Watch. If you sign in to your Apple devices
with the same Apple Account, you can easily share files and photos, edit documents,
answer email and calls, and send text among devices. See .

Learn more. See  and the Apple Support article 
.

Common questions about your Mac
How do I get support for my iMac? Go to .

I’m new to Mac. Are there tips for PC users? Yes. See  and the
Apple Support article . You might also be interested in

.

How do I take a screenshot on my Mac? Press Command-Shift-3 to take a screenshot
of the entire screen. Press Command-Shift-4 to take a screenshot of a selected area of
the screen. To learn more, see .

Where is my serial number? Choose Apple menu   > About This Mac. The serial
number is listed. You can also find the serial number on the bottom of the iMac stand.

How do I know which model of iMac I have? See the Apple Support article 
. You can also choose Apple menu   > About This Mac to view the model

information.

How can I find the documentation for my iMac? To find the iMac Getting Started Guide
guide, open System Settings, click the Help menu, then click User Manual. From the Help
menu, you can also click “macOS Help” to open the user guide for the operating system.

Take a
screenshot on your Mac

Siri on your Mac

Use iCloud with your iMac

What’s it called on my Mac? Mac
keyboard shortcuts

iMac Support

Are you new to Mac?
Mac tips for Windows switchers

Keyboard shortcuts on your Mac

Take a screenshot on your Mac

Identify your
iMac model

help:anchor='cpmh0038'%20bookID='com.apple.machelp'
https://support.apple.com/102650
https://support.apple.com/mac/imac
https://support.apple.com/102323
https://support.apple.com/108054
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For older Mac models, see .

How do I get help for an app? When you’re using the app, click the Help menu in the
menu bar at the top of the screen.

Where is the safety information for my iMac? See 
.

How do I find the technical specifications? Go to , or open System
Settings, click Help, then click iMac Specifications.

How do I hang my iMac on a wall? Use a VESA Mount Adapter. The VESA Mount
Adapter should only be installed or uninstalled by Apple. For support, contact an Apple
Retail Store or Apple Authorized Service Provider. For information about service, go to

.

How do I check my disk for problems? Use Disk Utility. See 
.

How do I reinstall macOS? Use macOS Recovery. See the Apple Support article 
.

Note: Beginning with macOS Big Sur, Time Machine backups don’t include system files.
See .

What should I do before selling or trading in my Mac? Back up your data, then restore
your Mac to factory settings. See 

.

Keyboard shortcuts on your Mac
You can press key combinations to do things on your iMac that you’d normally do with a
trackpad, mouse, or other device. Here’s a list of commonly used keyboard shortcuts.

Note: Keyboard shortcuts in apps may vary depending on the language and keyboard
layout you’re using on your Mac. If the shortcuts below don’t work as you expect, look in
the app menus in the menu bar to see the correct shortcuts. You can also use the
keyboard viewer to see your current keyboard layout, known as an input source. See 

.

Shortcut Description

Command-X Cut the selected item and copy it to the Clipboard.

Command-C Copy the selected item to the Clipboard.

Browse manuals by product

Important safety information for your
Mac

iMac Tech Specs

support.apple.com/mac/repair/service

Repair a storage device in
Disk Utility on Mac

How to
reinstall macOS

Back up and restore your Mac

What to do before you sell, give away, or trade in your
Mac

Use
the keyboard viewer on Mac

https://support.apple.com/manuals
https://www.apple.com/imac-24/specs/
https://support.apple.com/mac/repair/service
help:anchor='dskutl1040'%20bookID='com.apple.DiskUtility.help'
https://support.apple.com/102655
https://support.apple.com/102773
help:anchor='mchlp1015'%20bookID='com.apple.machelp'
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Command-V Paste the contents of the Clipboard into the current document or
app.

Command-Z Undo the previous command. Press Command-Shift-Z to redo.

Command-A Select all items.

Command-F Open a Find window, or find items in a document.

Command-G Find the next occurrence of the item you’re searching for. Press
Command-Shift-G to find the previous occurrence.

Command-H Hide the windows of the front app. Press Command-Option-H to
view the front app but hide all other apps.

Command-M Minimize the front window to the Dock. Press Command-Option-
M to minimize all windows of the front app.

Command-N Open a new document or window.

Command-O Open the selected item, or open a dialog to select a file to open.

Command-P Print the current document.

Command-S Save the current document.

Command-W Close the front window. Press Command-Option-W to close all
windows of the app.

Command-Q Quit the current app.

Command-Option-Esc Choose an app to Force Quit.

Command-Tab Switch to the next most recently used app among your open
apps.

Command-Shift-5 Open the Screenshot utility. You can also take screenshots using
the following shortcuts:

Press Command-Shift-3 to take a screenshot of the entire
screen.

Press Command-Shift-4 to take a screenshot of a selected
area of the screen.

>> When writing in a note, creates a link to another note of your
choice.

For more keyboard shortcuts, see the Apple Support article .Mac keyboard shortcuts

https://support.apple.com/102650
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Security features for iMac
Your iMac with Apple silicon provides security features to protect what’s on your
computer and prevent unauthorized software apps from loading during startup:

Secure startup: Support for secure startup is turned on automatically. It’s designed to
verify that the operating system software loaded on your computer at startup is
authorized by Apple.

If your iMac doesn’t start because it detects an untrusted component, it starts up
from a secure recovery partition and automatically corrects issues if possible. To
learn how to set security options, see 

.

Secure storage: Your iMac storage drive is encrypted with hardware keys to provide
advanced levels of security. In the event of a catastrophic failure, data recovery may
not be possible, so you need to back up your files to an external source. See 

.

You can set up Time Machine or another backup plan to regularly back up your files.
See , and the Apple Support article 

.

System integrity: The Apple silicon in your iMac is designed to verify that the version
of macOS software loaded during startup is authorized by Apple, and continues
behind the scenes to protect the authorizations established for macOS. This makes it
harder for malware or malicious websites to exploit your Mac.

Data Protection: In addition to the default storage drive encryption in iMac, third-
party app developers can use file-level encryption to better protect sensitive data,
without impacting system performance.

Note: In rare circumstances, such as a power failure during a macOS upgrade, your iMac
may become unresponsive and the firmware on the chip may need to be revived. See the
Apple Support article .

Learn more. See the .

Save space on your iMac
With Optimize Storage, you can automatically free up space on your iMac by making files
available on demand. Your oldest files are stored in iCloud and on your email IMAP or
Exchange server, so you can download them at any time. There are also tools to identify
and delete big files.

Change security settings on the startup disk of
a Mac with Apple silicon

Use
macOS Recovery on a Mac with Apple silicon

Back up your files with Time Machine Back up your
Mac with Time Machine

How to revive or restore Mac firmware

Apple Platform Security Guide

help:anchor='mchl768f7291'%20bookID='com.apple.machelp'
help:anchor='mchl82829c17'%20bookID='com.apple.machelp'
help:anchor='mh35860'%20bookID='com.apple.machelp'
https://support.apple.com/104984
https://support.apple.com/108900
https://support.apple.com/guide/security/welcome/web
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Optimize storage. To see storage recommendations, choose Apple menu   > System
Settings, then click General on the sidebar. Click Storage to see different
recommendations based on how you configured your Mac.

Set options to:

Store in iCloud: Store all files, photos, and messages in iCloud and save space on
your Mac.

Desktop and Documents: Store all the files from your Desktop and Documents
folders in iCloud Drive. When storage space is needed, iCloud Drive keeps
recently opened files on your Mac and makes your oldest files available on
demand.

Messages: Store all messages and attachments in iCloud. When storage space is
needed, iCloud keeps recent attachments on your Mac and makes your oldest files
available on demand.

Even though your files are stored in the cloud, you can access them right where you
left them on your iMac. See .

Optimize Storage: Save space on your Mac by optimizing the storage of movies and
TV shows in the Apple TV app. You can choose to automatically remove movies or TV
shows from your iMac after you watch them. You can download them again at any
time.

Empty Trash automatically: Automatically erase items that have been in the Trash for
more than 30 days.

Access your iCloud content on your Mac



10/11/24, 4:21 PMiMac

Page 122 of 135https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

To help you save space as you work, macOS also:

Prevents you from downloading the same file twice from Safari.

Alerts you to remove installer software when you finish installing a new app.

Clears logs and caches that are safe to remove when you’re low on storage.

Learn more. See .

Mac resources, service, and support
You can find more information about your iMac in System Report, in Apple Diagnostics,
and through online resources.

System Report. To get information about your iMac, use System Report. It shows you
your hardware model, the serial number and operating system version, how much
memory is installed, and more. To open System Report, choose Apple menu   > About
This Mac, click More Info, then click System Report.

Apple Diagnostics. You can use Apple Diagnostics to help determine if there’s a problem
with one of the computer’s components, such as the memory or processor. Apple
Diagnostics helps to identify the potential source of a hardware issue and provides first
steps to try and resolve it. Apple Diagnostics also helps you get in touch with
AppleCare Support if you need more help.

Before using Apple Diagnostics, disconnect all external devices except keyboard, mouse,
display, Ethernet connection (if applicable), and connection to AC power. Be sure the
computer is connected to the internet.

To start Apple Diagnostics, shut down your Mac, press and hold the power button until
you see the startup options window, then press and hold Command-D on your keyboard
to enter diagnostics mode. If prompted, select the language for your location. The basic
Apple Diagnostics test takes a few minutes to complete. If an issue is found, a description
of the issue appears with additional instructions. Make a note of any reference codes
before you exit Apple Diagnostics, in case you need to contact AppleCare Support. See

.

Online resources. For online service and support information, go to . You
can learn about Apple products, view online manuals, check for software updates,
connect with other Apple users, and get service, support, and professional advice from
Apple. For more information about your iMac, go to .

Optimize storage space on your Mac

Use Apple Diagnostics to test your Mac

Apple Support

iMac Support

help:anchor='sysp4ee93ca4'%20bookID='com.apple.machelp'
https://support.apple.com/102550
https://support.apple.com/
https://support.apple.com/mac/imac
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AppleCare support. If you need assistance, AppleCare representatives can help you
with installing and opening apps, and with troubleshooting. Call the support center
number nearest you (the first 90 days are complimentary). Have the purchase date and
your iMac serial number ready when you call.

A complete list of support telephone numbers is available on the web at 
. Telephone numbers are subject to change, and local and national

telephone rates may apply.

Your 90 days of complimentary telephone support begins on the date of purchase.

Contact Apple
for support and service

https://support.apple.com/106932
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Important safety information for your Mac
WARNING: Failure to follow these safety instructions could result in fire, electric

shock, or other injuries, or damage to your iMac, cables, or other property. Read all safety
information below before using your iMac.

Handling. Set up your iMac on a hard, stable work surface that allows for adequate air
circulation under and around the computer. Never push objects into the ventilation
openings. Your iMac can be damaged if dropped, burned, punctured, or crushed, or if it
comes in contact with liquids, oils, and lotions. Don’t use a damaged iMac, such as one
with a cracked screen, as it may cause injury.

Liquid exposure. Keep your iMac away from sources of liquid, such as drinks, oils,
lotions, washbasins, bathtubs, shower stalls, and so on. Protect your iMac from
dampness, humidity, or wet weather, such as rain, snow, and fog.

Power. The only way to turn off power completely to your 24-inch iMac is to unplug the
power cord from the wall outlet. For other iMac models, you can unplug the power cord
either from the wall outlet or from your computer. Make sure the power cord is within
easy reach so that you can unplug your iMac when you need to. Unplug the power cord
(by pulling the plug, not the cord) and disconnect all cables if any of the following
conditions exists:

The power cord or plug becomes frayed or otherwise damaged.

You spill something into the case.

Your iMac or power adapter is exposed to rain or excess moisture.

Your iMac has been dropped, or the case has been damaged.

You suspect that your iMac needs service or repair.

You want to clean the case (use only the recommended procedure, described later in
this document).

Power specifications:

Voltage: 100 to 240 V AC

Current: 2 A, maximum

Safety, handling, and regulatory information
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Frequency: 50 to 60 Hz

WARNING: Your AC cord has a three-wire grounding plug (a plug that has a grounding
pin). This plug fits only a grounded AC outlet. If you’re unable to insert the plug into an
outlet because the outlet isn’t grounded, contact a licensed electrician to replace the
outlet with a properly grounded one. Do not defeat the purpose of the grounding pin.

Hearing loss. Listening to sound at high volumes may damage your hearing. Background
noise, as well as continued exposure to high volume levels, can make sounds seem
quieter than they actually are. Use only compatible earbuds, headphones, or earpieces
with your iMac. Turn on the audio and check the volume before inserting anything into
your ear. See .

WARNING: To prevent possible hearing damage, do not listen at high volume levels
for long periods.

WARNING:

INGESTION HAZARD: This product contains a button cell or coin battery.

DEATH or serious injury can occur if ingested.

A swallowed button cell or coin battery can cause Internal Chemical Burns in as little
as 2 hours.

KEEP new and used batteries OUT OF REACH OF CHILDREN.

Seek immediate medical attention if a battery is suspected to be swallowed or
inserted inside any part of the body.

Repairing. Your iMac should only be serviced by a trained technician. Disassembling
your iMac may damage it or may cause injury to you. If you attempt to open your iMac,
you risk damaging your computer, and such damage isn’t covered by the limited warranty
on your iMac. If your iMac needs service, is damaged, malfunctions, or comes in contact
with liquid, contact Apple or an Apple Authorized Service Provider for service. Repairs
performed by untrained individuals or using non-genuine Apple parts may affect the
safety and functionality of the device. You can find information about getting service at

.

Sound and Hearing

Mac Repair and Service

https://www.apple.com/sound/
https://support.apple.com/mac/repair/service
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Navigation. Maps, directions, and location-based apps depend on data services. These
data services are subject to change and may not be available in all areas, resulting in
maps, directions, or location-based information that may be unavailable, inaccurate, or
incomplete. Compare the provided location-based information to your surroundings and
defer to posted signs to resolve any discrepancies. Do not use these services while
performing activities that require your full attention. Always comply with posted signs and
the applicable laws and regulations in the areas where you are using navigation, and
always use common sense.

Medical device interference. iMac contains components and radios that emit
electromagnetic fields. These electromagnetic fields may interfere with medical devices,
such as pacemakers and defibrillators. Consult your physician and medical device
manufacturer for information specific to your medical device and whether you need to
maintain a safe distance of separation between your iMac and your medical device (more
than 6 inches or 15 cm apart). If you suspect iMac is interfering with your medical device,
stop using iMac and consult your physician and your medical device manufacturer.

Medical conditions. If you have a medical condition that you believe could be affected
by using iMac (for example, seizures, blackouts, eyestrain, or headaches), consult with
your physician prior to using iMac.

Repetitive motion. When you perform repetitive activities such as typing or playing
games on iMac, you may experience discomfort in your hands, arms, wrists, shoulders,
neck, or other parts of your body. If you experience discomfort, stop using iMac and
consult a physician.

High-consequence activities. Your iMac is not intended for use where the failure of the
computer could lead to death, personal injury, or severe environmental damage.

Explosive and other atmospheric conditions. Using iMac in any area with a potentially
explosive atmosphere may be hazardous—particularly in areas where the air contains
high levels of flammable chemicals, vapors, or particles such as grain, dust, or metal
powders. Exposing iMac to environments having high concentrations of industrial
chemicals, including evaporating liquified gases such as helium, may damage or impair
iMac functionality. Obey all signs and instructions.

For Australian customers, see the .Online Safety resources website

https://www.apple.com/au/legal/online-safety/
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Important handling information for your Mac
Operating environment. Operating your iMac outside these ranges may affect
performance:

Operating temperature: 50° to 95° F (10° to 35° C)

Storage temperature: -40° to 116° F (-40° to 47° C)

Operating altitude: Tested up to 16,404 feet (0 to 5000 meters)

Do not operate your iMac in areas with significant amounts of airborne dust, or smoke
from cigarettes, cigars, ashtrays, stoves, or fireplaces, or near an ultrasonic humidifier
using unfiltered tap water. Tiny airborne particles produced by smoking, cooking,
burning, or using an ultrasonic humidifier with unfiltered water may, in rare instances,
enter the ventilation openings of your iMac and, under certain conditions, result in a slight
haze on the inside surface of the glass panel that covers the iMac display.

Carrying your iMac. Before you lift or reposition your iMac, shut it down and disconnect
all cables and cords. To lift your iMac, hold its sides.

CAUTION: Keep hands and fingers away from the moving parts to avoid pinching.

Using connectors and ports. Never force a connector into a port. Before you plug the
power cord into the power port, make sure the power port is completely free of debris.
When connecting a device to a port, make sure the port is completely free of debris, that
the connector matches the port, and that you have positioned the connector correctly in
relation to the port.

Important: Use only the original cables that came with your computer or accessory, or
cables sold at an Apple retail store or online at .

Storing your iMac. If you are going to store your iMac for an extended period of time,
keep it in a cool location (ideally, 71° F or 22° C).

Cleaning your iMac. When cleaning the outside of your iMac and its components, first
shut down your iMac, then unplug all cords and cables. Then dampen a clean, soft, lint-
free cloth to wipe the iMac exterior. Avoid getting moisture in any openings. Don’t spray
liquid directly on the computer. Don’t use alcohol, aerosol sprays, solvents, abrasives, or
cleaners containing hydrogen peroxide that might damage the exterior finish.

Cleaning the display. To clean the nano-texture glass display, first shut down your iMac,
then unplug all cords and cables. Clean the display using only the polishing cloth that
came with your iMac.

apple.com

https://www.apple.com/
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Note: For infrequent cleaning of hard-to-remove substances, you can dampen the
polishing cloth with a 70-percent isopropyl alcohol (IPA) solution. See the Apple Support
article .

If your iMac display has standard glass, clean it using the included polishing cloth or a
clean microfiber cloth dampened with water. Don’t spray liquid directly on the screen.

Cleaning the Magic Keyboard or Magic Mouse. Turn off the device, then unplug the
cable (if necessary). To clean the outside of your mouse or keyboard, use a clean, soft,
lint-free cloth that’s been lightly moistened with water. Don’t get moisture in any
openings or use aerosol sprays, solvents, or abrasives.

Mac ergonomics
When you use the keyboard and mouse, your shoulders should be relaxed. Your upper
arm and forearm should form an angle that is slightly greater than a right angle, with your
wrist and hand in roughly a straight line.

How to clean the nano-texture glass on your Apple display

https://support.apple.com/104948
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Use a light touch when typing or using the trackpad and keep your hands and fingers
relaxed. Avoid rolling your thumbs under your palms.

Change hand positions often to avoid fatigue. Some computer users might develop
discomfort in their hands, wrists, or arms after intensive work without breaks. If you begin
to develop chronic pain or discomfort in your hands, wrists, or arms, consult a qualified
health specialist.

Mouse or optional trackpad. Position the mouse or trackpad at the same height as the
keyboard and within a comfortable reach.

Chair. An adjustable chair that provides firm, comfortable support is best. Adjust the
height of the chair so your thighs are horizontal and your feet are flat on the floor. The
back of the chair should support your lower back (lumbar region). Follow the
manufacturer’s instructions for adjusting the backrest to fit your body properly.

Display. Arrange the display so that the top of the screen is slightly below eye level when
you’re sitting at the keyboard. The best distance from your eyes to the screen is up to
you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).

Position the display to minimize glare and reflections from overhead lights and windows.
The stand lets you set the display at the best angle for viewing, helping to reduce or
eliminate glare from lighting sources you can’t move.

For more information about ergonomics, see the Apple Support article .

Regulatory information
Regulatory information, certification, and compliance marks specific to iMac are available
on-device. Choose Apple menu   > About This Mac, then click Regulatory Certification.

Ergonomics

https://www.apple.com/about/ergonomics
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FCC compliance statement
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in
a particular installation.

If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this product not authorized by Apple could void the
electromagnetic compatibility (EMC) and wireless compliance and negate your authority
to operate the product.

This product has demonstrated EMC compliance under conditions that included the use
of compliant peripheral devices and shielded cables between system components. It is
important that you use compliant peripheral devices and shielded cables between system
components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices.

Exposure to radio frequency energy. The radiated output power of this device meets
the limits of FCC/IC radio frequency exposure limits. This device should be operated with
a minimum separation distance of 20 cm (8 inches) between the equipment and a
person’s body.



10/11/24, 4:21 PMiMac

Page 131 of 135https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

The operation of this device is prohibited on oil platforms and aircraft, except that
operation of this device in 5.925-6.425 GHz is permitted in large aircraft while flying
above 10,000 feet.

Installation on outdoor fixed infrastructure is prohibited.

Operation of transmitters in the 5.925-7.125 GHz is prohibited for control of or
communications with unmanned aircraft systems.

Responsible party (contact for FCC matters only):
Apple Inc.
One Apple Park Way, MS 911-AHW
Cupertino, CA 95014
USA

ISED Canada compliance statement
This device complies with ISED Canada licence-exempt RSS standard(s). Operation is
subject to the following two conditions: (1) this device may not cause interference, and
(2) this device must accept any interference, including interference that may cause
undesired operation of the device.

Operation in the band 5150–5250 MHz is only for indoor use to reduce the potential for
harmful interference to co-channel mobile satellite systems.

Operation in 5925-7125 MHz band shall not be used for control of or communications
with unmanned aircraft systems.

Exposure to radio frequency energy. The radiated output power of this device meets
the limits of FCC/ISED Canada radio frequency exposure limits. This device should be
operated with a minimum separation distance of 20 cm (8 inches) between the
equipment and a person’s body.

Le présent appareil est conforme aux CNR d’ISDE Canada applicables aux appareils radio
exempts de licence. L’exploitation est autorisée aux deux conditions suivantes : (1)
l’appareil ne doit pas produire de brouillage, et (2) l’appareil doit accepter tout brouillage
radioélectrique subi, même si le brouillage est susceptible d’en compromettre le
fonctionnement.

La bande 5150–5250 MHz est réservée uniquement pour une utilisation à l’intérieur afin
de réduire les risques de brouillage préjudiciable aux systèmes de satellites mobiles
utilisant les mêmes canaux.

apple.com/contact

https://www.apple.com/contact
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Les appareils dans la bande 5925-7125 MHz ne doivent pas être utilisés pour contrôler
des systèmes d’aéronefs sans pilote ou pour communiquer avec de tels systèmes.

L’exposition à l’énergie radiofréquence. La puissance de sortie rayonnée de cet
appareil est conforme aux limites de la FCC/ISDE Canada limites d’exposition aux
fréquences radio. Cet appareil doit être utilisé avec une distance minimale de séparation
de 20 cm entre l’appareil et le corps d’une personne.

ENERGY STAR® compliance statement

As an ENERGY STAR partner, Apple has determined that standard configurations of this
product meet the ENERGY STAR guidelines for energy efficiency. The ENERGY STAR
program is a partnership with electronic equipment manufacturers to promote energy-
efficient products. Reducing energy consumption of products saves money and helps
conserve valuable resources.

iMac is shipped with power management enabled, with the computer set to sleep after 10
minutes of user inactivity. To wake your computer, click the mouse or trackpad or press
any key on the keyboard. To change this setting, open System Settings, then click Lock
Screen.

iMac meets the ENERGY STAR guidelines for energy efficiency. For more information
about ENERGY STAR, go to the .

Apple and the environment
At Apple, we recognize our responsibility to minimize the environmental impacts of our
operations and products.

For information, go to Apple’s  website.

Disposal and recycling information

Energy Star website

Environment

https://www.energystar.gov/
https://www.apple.com/environment
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The symbol above means that according to local laws and regulations your product
and/or its battery shall be disposed of separately from household waste. When this
product reaches its end of life, take it to a collection point designated by local authorities.
The separate collection and recycling of your product and/or its battery at the time of
disposal will help conserve natural resources and ensure that it is recycled in a manner
that protects human health and the environment.

For information about Apple’s recycling program, recycling collection points, restricted
substances, and other environmental initiatives, visit .

Información sobre eliminación de residuos y reciclaje

El símbolo de arriba indica que este producto y/o su batería no deben desecharse con los
residuos domésticos. Cuando quieras desechar este producto y/o su batería, hazlo de
conformidad con las leyes y directrices medioambientales locales. Para obtener más
información sobre el programa de reciclaje de Apple, los puntos de recolección para
reciclaje, las sustancias restringidas y otras iniciativas medioambientales, visita

 o .

Brasil – Informações sobre descarte e reciclagem

O símbolo acima indica que este produto e/ou sua bateria não devem ser descartados no
lixo doméstico. Quando decidir descartar este produto e/ou sua bateria, faça-o de acordo
com as leis e diretrizes ambientais locais. Para informações sobre substâncias de uso
restrito, o programa de reciclagem da Apple, pontos de coleta e telefone de informações,
visite .

Apple Recycling Program

For free recycling of your old device, a prepaid shipping label, and instructions, see 
.

Note: The Apple Recycling program is not available in all countries and regions.

Turkey environmental information

Türkiye Cumhuriyeti: AEEE Yönetmeliğine Uygundur.

Software License Agreement
Use of iMac constitutes acceptance of the Apple and third-party software license terms
found at .

Copyright © 2024 Apple Inc. All rights reserved.

apple.com/environment

apple.com/mx/environment apple.com/la/environment

apple.com/br/environment

Apple
Trade In website

Software License Agreements

https://www.apple.com/environment
https://www.apple.com/mx/environment/
https://www.apple.com/la/environment
https://www.apple.com/br/environment
https://www.apple.com/shop/trade-in
https://www.apple.com/legal/sla
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Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent
of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.
Apple, the Apple logo, Apple Studio Display, AirDrop, AirPlay, AirPods, AirPort Time Capsule, AirTag,
Apple Books, Apple Card, Apple Music, Apple Pay, Apple Pencil, Apple Podcasts, Apple Pro Display XDR,
Apple TV, Apple Wallet, Apple Watch, FaceTime, FileVault, Finder, Find My, Freeform, GarageBand, Handoff,
HomeKit, HomePod, iMac, iMessage, iMovie, iPad, iPadOS, iPhone, iPod, iPod touch, Keychain, Keynote,
Launchpad, Lightning, Mac, macOS, Magic Keyboard, Magic Mouse, Magic Trackpad, Memoji,
Mission Control, Night Shift, Numbers, Pages, Retina, Safari, Sidecar, Siri, Spotlight, Stage Manager,
Time Machine, Touch ID, and True Tone are trademarks of Apple Inc., registered in the U.S. and other
countries and regions.

Center Stage, Force Touch, and SharePlay are trademarks of Apple Inc.

App Store, Apple Arcade, AppleCare, Apple News, Apple One, iCloud, iCloud+, iCloud Drive, iCloud Keychain,
and iTunes Store are service marks of Apple Inc., registered in the U.S. and other countries and regions.

Apple

One Apple Park Way
Cupertino, CA 95014

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Apple Inc. is under license.

ENERGY STAR and the ENERGY STAR mark are registered trademarks owned by the U.S. Environmental
Protection Agency.

Other company and product names mentioned herein may be trademarks of their respective companies.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible
for printing or clerical errors.

Some apps are not available in all areas. App availability is subject to change.

Copyright © 2024 Apple Inc. All rights reserved.

Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent
of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.

Apple, the Apple logo, Apple Studio Display, AirDrop, AirPlay, AirPods, AirPort Time Capsule, AirTag,
Apple Books, Apple Card, Apple Music, Apple Pay, Apple Pencil, Apple Podcasts, Apple Pro Display XDR,
Apple TV, Apple Wallet, Apple Watch, FaceTime, FileVault, Finder, Find My, Freeform, GarageBand, Handoff,
HomeKit, HomePod, iMac, iMessage, iMovie, iPad, iPadOS, iPhone, iPod, iPod touch, Keychain, Keynote,
Launchpad, Lightning, Mac, macOS, Magic Keyboard, Magic Mouse, Magic Trackpad, Memoji,
Mission Control, Night Shift, Numbers, Pages, Retina, Safari, Sidecar, Siri, Spotlight, Stage Manager,
Time Machine, Touch ID, and True Tone are trademarks of Apple Inc., registered in the U.S. and other
countries and regions.

Center Stage, Force Touch, and SharePlay are trademarks of Apple Inc.

App Store, Apple Arcade, AppleCare, Apple News, Apple One, iCloud, iCloud+, iCloud Drive, iCloud Keychain,
and iTunes Store are service marks of Apple Inc., registered in the U.S. and other countries and regions.

Apple
One Apple Park Way
Cupertino, CA 95014

apple.com

https://www.apple.com/
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IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Apple Inc. is under license.

ENERGY STAR and the ENERGY STAR mark are registered trademarks owned by the U.S. Environmental
Protection Agency.

Other company and product names mentioned herein may be trademarks of their respective companies.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible
for printing or clerical errors.

Some apps are not available in all areas. App availability is subject to change.
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